
SWRate User’s Manual v2.2.1 Page 1 of 44 

 

 
 

 

 

 

 

 

 

 

 

 

SWRate User’s Manual  
v2.2.1 

 
 

 

 

 

 

  



SWRate User’s Manual v2.2.1 Page 2 of 44 

 

 
 

Table of Contents 
 

1   Welcome to SWRate Software ................................................................................................................................ 4 

1.1   What is SWRate Software? ..................................................................................................................................... 4 

1.2   Who Can Use SWRate Software? ............................................................................................................................ 4 

1.3   SWRate Highlights .................................................................................................................................................. 4 

1.3.1   SWRate Features ......................................................................................................................................................... 4 

1.4   Installation .............................................................................................................................................................. 5 

1.4.1   Southwire’s SWRate Software Package Includes: ....................................................................................................... 5 

1.4.2   SWRate Installation Instructions ................................................................................................................................. 6 

1.4.3   SWRate Pro Licensing .................................................................................................................................................. 7 

1.4.4   Automated Updating ................................................................................................................................................. 13 

1.5   Technical Support .................................................................................................................................................. 13 

2   Main Menu Features ............................................................................................................................................. 13 

2.1   Main Menu Toolbar Controls ................................................................................................................................ 14 

2.1.1   File Menu ................................................................................................................................................................... 14 

2.1.2   Help Menu ................................................................................................................................................................. 15 

2.1.3   Upgrade to Pro Menu (Lite Version Only) ................................................................................................................. 15 

2.2   Conductor Selection .............................................................................................................................................. 15 

2.2.1   Custom ...................................................................................................................................................................... 15 

2.2.2   Create Custom ........................................................................................................................................................... 16 

2.3   Conductor Construction Information ..................................................................................................................... 17 

2.3.1   Conductor Information .............................................................................................................................................. 17 

2.3.2   Core Information ....................................................................................................................................................... 18 

2.3.3   Trapwire Information ................................................................................................................................................ 19 

2.3.4   Surface (Pro version only) ......................................................................................................................................... 19 

2.3.5   Thermal Coeffs .......................................................................................................................................................... 19 

2.3.6   Construction (Pro Version Only) ................................................................................................................................ 20 

2.3.7   Spec Sheet Information ............................................................................................................................................. 20 

2.3.8   Low Temperature and High Temperature AC Resistance ......................................................................................... 20 

2.3.9   Custom Materials ...................................................................................................................................................... 21 

2.4   Calculation Conditions ........................................................................................................................................... 22 



SWRate User’s Manual v2.2.1 Page 3 of 44 

 

 
 

2.4.1   Local Conditions ........................................................................................................................................................ 23 

2.4.2   Location Conditions ................................................................................................................................................... 23 

2.5   Output Selections .................................................................................................................................................. 24 

2.5.1   Resistance (Resis.) Units ............................................................................................................................................ 24 

2.5.2   Temperatures ............................................................................................................................................................ 24 

2.6   Condition Settings (Pro version only) ..................................................................................................................... 26 

2.6.1   Profiles ....................................................................................................................................................................... 26 

2.6.2   Reset .......................................................................................................................................................................... 26 

2.6.3   Restore Default ......................................................................................................................................................... 26 

2.6.4   Save As Default .......................................................................................................................................................... 26 

2.7   Calculation Options ............................................................................................................................................... 27 

2.7.1   Loss of Strength ......................................................................................................................................................... 27 

2.7.2   Steady-State Conductor Temperature ...................................................................................................................... 28 

2.7.3   Steady-State Current Rating ...................................................................................................................................... 29 

2.7.4   Transient Conductor Temperature (Unavailable for Covered Conductors) .............................................................. 30 

2.7.5   Transient Current Rating (Unavailable for Covered Conductors) ............................................................................. 32 

2.7.6   Calculate Ampacity (Pro version only) ...................................................................................................................... 33 

2.7.7   Batch Ampacity (Pro version only) ............................................................................................................................ 35 

2.7.8   Create Spreadsheet (Pro version only) ..................................................................................................................... 37 

2.7.9   Bundled Calculation (Pro version only) ..................................................................................................................... 40 

Appendix ................................................................................................................................................................... 42 

 

 

 

 

 

 

 



SWRate User’s Manual v2.2.1 Page 4 of 44 

 

 
 

1   Welcome to SWRate Software 

1.1   What is SWRate Software? 
Southwire’s SWRate software is a PC-based program that calculates resistance, reactance, and thermal ratings of 

overhead conductors in accordance with current standards. SWRate Lite software is available as a no-cost “lite” version 

of the SWRate Pro software. Each software includes an extensive database of overhead conductors and cables. The 

calculation methods used in SWRate software are based on IEEE 738-2012. Data provided in the conductor tables and 

conductor calculations are based on ASTM 02.03-2020.   

1.2   Who Can Use SWRate Software? 
Southwire intends the SWRate program to be used by qualified engineers and designers who have a foundation of 

knowledge in overhead power transmission and distribution lines, and the performance of conductors used in those 

lines. When using the SWRate program, a qualified engineer should review the parameters input for the calculations, 

and the resulting calculated data, and verify that they are correct for the specific application. 

1.3   SWRate Highlights  

1.3.1   SWRate Features 

Inside an easy-to-use menu-driven interface, SWRate software will calculate, for a specific set of input conditions: 

• DC/AC resistance at any operating temperature (interpolated resistance mode also available) 

• DC/AC thermal ratings for a determined temperature range under various combinations of solar and wind 

conditions (Pro version only) 

• A steady-state conductor thermal rating for a given conductor temperature 

• A steady-state conductor temperature given a steady-state current 

• A transient conductor thermal rating provided a maximum transient temperature, duration, and starting 

condition 

• A transient conductor temperature provided a transient current, duration, and starting condition 

• Conductor GMR (Pro version only) 

• Conductor reactance for various bundle/phase configurations (Pro version only) 

• Batch steady-state and transient results for multiple conductors and multiple sets of calculation conditions, 

including columns for conductor properties, resistance, and reactance (Pro version only) 

• Results in U.S. Standard or Metric units 
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Data furnished includes conductor properties for the following conductor types: 

• AAC 

• AAC/TW 

• AAAC 

• ACAR 

• AACSR 

• ACSR 

• ACSR/TW 

• ACSR/MR 

• ACSR/AW 

• ACSS 

• ACSS/TW 

• ACSS/AW 

• ACSS/TW/AW 

• MaxStormTM 

• ACCS/TW/C7®-TS 

• ZTACCR/TW/C7®-TS 

• ACCS/TW/C7®-TP 

• ZTACCR/TW/C7®-TP 

• ACCR 

• ACCR/TW 

• AAC/VR2 

• ACSR/VR2 

• Al Bare 

• Al Duplex 

• Al Triplex 

• Al Quadruplex 

• HD Copper 

• MHD Copper 

• SD Copper 

• Cu Duplex 

• Cu Triplex 

• Cu Quadruplex 

• AAC Line Wire 

• AAAC Line Wire 

• ACSR Line Wire 

• AAC Tree Wire/Spacer Cable 

• ACSR Tree Wire 

• C7® Tree Wire 

 

Covered conductors are only available in the Pro version. Custom conductors can also be modeled, saved, and deleted (Pro 

version only). See Section 2.2, Conductor Selection, for more information. 

1.4   Installation 

1.4.1   Southwire’s SWRate Software Package Includes: 

1. Product key 

2. Download link 

3. Installation Instructions link 

4. Documentation link 

5. User’s Manual link 

6. Other helpful links 
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1.4.2   SWRate Installation Instructions 

 

1. After downloading the SWRate installer, double-click the “SWRate_install.msi” file to begin installing SWRate 

software. 

 

              Click Next on the Welcome to the SWRate Setup Wizard screen. 

 

2. By default, the SWRate program will be installed under the “C:\Program Files (x86)\Southwire\SWRate” 

folder. 

3. Click Finish. 
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4. To launch the SWRate program, either double-click the Desktop shortcut or search “SWRate” in the Start 

menu. 

1.4.3   SWRate Pro Licensing 

If you have purchased SWRate Pro software, you will need to enter a valid product key to activate the full 

version of the software with Advanced features. To do so, click Upgrade to Pro at the top of the SWRate 

Main Menu screen after opening the program (Contact OHT@southwire.com for a product key). 

1. In the Southwire Licensing screen, enter your Product Key in the space provided.  

mailto:OHT@southwire.com
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2. By default, the License Source will be set to Internet. If you do not have a valid internet connection, you 

may choose the Email option.  

a) If you choose Internet and DO NOT use a proxy service, proceed to Step 3 below. 

b) If you choose Internet and need to use a proxy service, check the box beside Use Proxy Service and 

click Configure Proxy Service.  

 

Next, enter your proxy server address and click Accept.  

Finally, proceed to Step 3 below. 
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c) If you choose Email, you will need to request a license file. 

i. Click the Request button. 

ii. You will be prompted to select a folder under which to save the license request file (Ex: 

filename “LicenseRequest.YYYY-MM-DD.xml” will be generated). 

iii. Click OK. 

iv. A window will appear with instructions on where to email the previously generated license 

request file. 

 



SWRate User’s Manual v2.2.1 Page 10 of 44 

 

 
 

 

v. When you receive the license file from Southwire, reopen the program and click Upgrade to 

Pro at the top of the Main Menu screen. Within the Southwire Licensing screen, again click 

Email under License Source, then click the Process button to apply the license file. You will 

need to navigate to the folder where the license file is located (Ex: “test_license.lic”) and 

click Open. If successful, proceed to Step 4.  

 

3. Click the Checkout button. 

4. Once a license is successfully checked out, the Status section of License Information will be updated to say 

Licensed and will be visibly green. 
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5. Click Close. 

6. You will be prompted with the SWRate End User License Agreement (EULA) and will need to click Accept or 

Decline. 
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7. Upon acceptance of the EULA, the program will reload, and you will be able to use the SWRate Pro 

program. 
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1.4.4   Automated Updating  

If a software or data update is available for SWRate Pro, you will be prompted to incorporate the updates if: (1) you 

currently hold a maintenance contract and (2) the computer you are using is connected to the internet. The process for 

installing software updates will be similar to the installation process. Data updates will be automatic. 

1.5   Technical Support  
For assistance, contact SWRate technical support at 1-877-797-2410, OHT@southwire.com, or visit us at 

https://overheadtransmission.southwire.com/swrate-software-support/. 

2   Main Menu Features 
The Main Menu screen is divided into different sections, as shown below.  

 

These sections are: 

• Main Menu Toolbar: This toolbar contains the Main Menu tabs, which allow access to program Options, 

Printer options, and Help. 

• Conductor Selection: Type and Name inputs for selecting a conductor 

• Primary Conductor Construction Information: Two (2) panels, one for information on the selected conductor’s 

mailto:OHT@southwire.com
https://overheadtransmission.southwire.com/swrate-software-support/
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outer conducting strands (Conductor Information) and one for information on the core (Core Information), if 

applicable 

• Additional Conductor/Cable Information: Seven (7) panels containing additional information used for 

calculations, including some used strictly for the specification sheet 

• Calculation Conditions: Two (2) panels are available for specifying the Local Conditions and Location Conditions. 

An additional panel, the Condition Settings panel, allows saving and selection of calculation conditions. 

• Calculation Options: Four (4) panels, one for Loss of Strength calculations, one for single Steady-State 

calculations, one for single Transient calculations, and one for Advanced calculations (Pro version only). The 

Steady-State and Transient panels contain two options, one to calculate a conductor temperature given a 

current input, and the second to calculate a current rating given a conductor temperature input. The Advanced 

panel (Pro version only) has button options for (1) creating a table of ampacities under given input conditions, 

(2) outputting a collection of ampacity calculation sheets for multiple conductors, (3) outputting a spreadsheet 

of steady-state and transient results for multiple conductors and multiple sets of calculation conditions, 

including columns for conductor properties, resistance, and reactance, and (4) reactance calculations for 

various bundle/phase configurations. 

2.1   Main Menu Toolbar Controls 

2.1.1   File Menu 

The File tab on the Main Menu provides access to two options:  

• Options: 

o Drop-down Sorting: The Name drop-down list can be sorted either alphabetically by code word (if 

applicable) or by conductor size. Regardless of sorting method, the code word (if applicable), conductor 

size, and stranding/type number will be shown. 

o Sequence Impedance Info: Inputs used by the Sequence Impedance portion of the Calculate Ampacity 

calculation routine (Pro version only) 

o Resistance Mode: Select the mode for calculating ac resistance. Calculate Resistance calculates ac 

resistance for steady-state calculations considering the skin effect and hysteresis and eddy current 

effects [for single-layer and three-layer steel core conductors (aluminum-clad steel, AW, excluded)]. The 

skin effect is calculated per “Skin Effect in Tubular and Flat Conductors” by H.B. Dwight. Hysteresis and 

eddy current effects are calculated per "The Resistance and Reactance of Aluminum Conductors, Steel 

Reinforced" by Lewis and Tuttle and "The Magnetic Properties of ACSR Core Wire" by Matsch and Lewis for 

single-layer steel core conductors and per “AC Resistance of ACSR – Magnetic and Temperature Effects” by 

D.A. Douglass for three-layer steel core conductors. Interpolate Resistance interpolates between the 

Low and High Temperature AC Resistance values on the Main Menu for steady-state calculations. 
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Regardless of Resistance Mode selection, transient calculations use interpolated resistance. This is 

because transient calculations require a complex, iterative process to calculate transient ratings. 

• Printer: Activates the printer selection and setup dialog box 

• Exit and Check-In License: Closes the application and checks in the license seat for use by another user 

2.1.2   Help Menu 

The Help tab on the Main Menu provides access to the following options:  

• About: Displays the currently installed program version number, calculation method references, and contact 

information for technical support: OHT@southwire.com or 1-877-797-2410 

• Help: Contains instruction on how to activate context sensitive help for the input items on the Main Menu. 

When the cursor is placed into an input field either with the mouse or moved there using the Tab key, you can 

access help for the value to be entered, if available, by pressing the F1 key. 

• Revision History: Details improvements to the software (Pro version only) 

• View Disclaimer: Displays the disclaimer for the software (Lite version only) 

• User’s Manual: Opens this User’s Manual 

2.1.3   Upgrade to Pro Menu (Lite Version Only) 

This toolbar option allows you to license your SWRate software to run SWRate Pro. Contact OHT@southwire.com to 

purchase an SWRate Pro license. 

2.2   Conductor Selection  
Conductor selection is done in two steps. First, select the Type of conductor to be used (AAC, ACSR, etc.) from the Type 

drop-down menu. The available conductor types are discussed in the Appendix. Detailed information on each type of 

conductor can be found in the Southwire Overhead Conductor Manual, which can be purchased at 

https://southwireocm.p3medialink.com/product_detail.php?id=71. Some conductor types, notably covered 

conductors, are not available in the Lite version. 

 

After selecting a conductor Type, the Name drop-down list will be populated with available conductor options. Select 

the desired conductor in this drop-down. After a selection has been made, the Conductor Construction Information will 

be automatically filled in, including the conductor Size in kcmil or AWG.  

2.2.1   Custom (Pro Version Only) 

This conductor Type contains all the custom conductors that you have saved. Custom conductors will also appear in the 

bottom of the Name drop-down when the custom conductor Type matches a conductor type in the Type drop-down list. 

mailto:OHT@southwire.com
mailto:OHT@southwire.com
https://southwireocm.p3medialink.com/product_detail.php?id=71
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Once selected, a custom conductor can be deleted by clicking the Delete Custom button. 

2.2.2   Create Custom (Pro Version Only) 

Select this conductor Type to enter the Custom Type screen. 

  

The Custom Type screen assists in the creation of a custom conductor. There are several selection options available:  

• Conductor Type: Select either a standard conductor Type or enter a custom conductor Type into the Other 

field. Selection of a standard conductor Type will automatically configure and lock each of the primary 

checkboxes within the Additional Information panel. 

• Additional Information: 

o Homogeneous: Check if the custom conductor has individual strands of a single material. Do not check 

if the custom conductor consists of mixtures of wires of different materials. 

o Coated Steel Core (Galvanized or Mischmetal): Check if the custom conductor has a coated steel core, 

either galvanized (zinc-coated), mischmetal (zinc-5% aluminum-mischmetal alloy-coated), or aluminized 

(aluminum-coated). If the custom conductor has an aluminum-clad (AW) steel core, leave unchecked. 

o Trapwire (TW): Check if the custom conductor consists of one or more layers of trapezoidal-shaped 

wire helically wrapped over a round wire core. The core may consist of a single round wire for 

homogeneous aluminum conductors, a single wire or concentric-lay-stranded, same-size core strands 
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for ACAR, ACSR, and ACSS conductors. 

 

Once you have made your selections, click Accept. Fields will automatically populate based on your selections. To finish 

designing your custom conductor, enter the remaining conductor data per Section 2.3, Conductor Construction Information. 

Remember to also update the Size and Name as necessary. The custom conductor Name cannot match an existing conductor 

Name. When finished, click Save to Custom to save the custom conductor to the Custom conductor database. Before the 

saving process is complete, the Enter Conductor Weights screen will appear and conductor weights will need to be entered 

for transient calculation purposes. 

 

Custom conductors can also be created by editing/entering conductor data per Section 2.3, Conductor Construction 

Information, and clicking Save to Custom. 

 

Custom conductors will appear in the Custom conductor Type as well as the bottom of the Name drop-down when the 

custom conductor Type matches a conductor type in the Type drop-down list. 

2.3   Conductor Construction Information 
There are two panels on the main input form that contain the primary Conductor Construction information for the 

selected conductor. The first contains information on the outer conducting strands, and the second contains 

information on the core, if applicable. 

2.3.1   Conductor Information  

For purposes of the calculations in this program, the conducting strands are assumed to be the primary electrical 

conducting member of the construction. Conductor strands can be different types of aluminum, aluminum alloy, and 

copper.  

 

There are seven fields in this panel:  
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• Material: Material name for the outer conducting strands 

• Strand Count: Number of outer conducting strands  

• Strand Diameter: Diameter of each individual outer conducting strand, inches. Due to the irregular shape of 

Trapezoidal-shaped Wire (TW) strands, the outer conducting strand diameter is not input for TW constructions. 

• Stranding Factor: Length increment due to stranding 

• Outer Diameter: Overall diameter of the conductor, inches 

• Compression: Choose Compact for designs with compact (TW) strands. Choose Compressed for designs with 

compressed outer strands. Compressed will be automatically selected for Al/Cu Duplex, Al/Cu Triplex, Al/Cu 

Quadruplex, and AAC Line Wire. For TW and other compact aluminum conductors not already in the database, 

each conductor layer diameter and number of strands per layer are required as inputs in the Layer Information 

screen after selecting Compression => Compact in order for GMR and inductive reactance to calculate. 

• Strand Lay [single-layer steel core conductors (aluminum-clad steel, AW, excluded) only]: Length of lay of the 

outer strands  

2.3.2   Core Information  

For purposes of the calculations in this program, the core is defined as the mechanical support member of the 

conductor. The core can be composed of coated steel wire, aluminum-clad steel wire (AW), C7® stranded carbon fiber 

composite core, 3M® composite core, or aluminum alloy (when used as a core material in ACAR constructions).  

 

There are five fields in this panel: 

• Material: Material name for the core strands 

• Strand Count: Number of core strands 

• Strand Diameter: Diameter of each individual core strand, inches 

• Stranding Factor: Length increment due to stranding 

• Core Diameter: Overall diameter of the core, inches 
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2.3.3   Trapwire Information  

When a TW construction (e.g., ACSS/TW) is selected, the number of Layers of aluminum strands and the Type number 

(core to aluminum area ratio in percent) will be automatically populated. 

  

2.3.4   Surface (Pro Version Only) 

This selection will affect the thermal coefficients (Thermal Coeffs) and subsequent rating calculations. The Black and 

Gray options are intended for covered conductors. 

 

2.3.5   Thermal Coeffs 

Although the surface condition of the conductor/cable can be selected in the Surface panel, Absorptivity and 

Emissivity can also be custom defined in the Thermal Coeffs panel. 

 

Emissivity is defined as the ratio of heat radiated to the surrounding air by the conductor to the heat radiated to the 

surrounding air by a perfect “black body” radiator of the same dimensions.  

 

Absorptivity is the ability of a conductor to absorb heat from its surroundings and is dependent upon conductor surface 

conditions. Although solar heat absorption occurs at a different frequency range than heat radiation, both the 

absorptivity and emissivity of an overhead conductor will increase over the life of the conductor, as a result of age and 

atmospheric pollution. 

 

Absorptivity and emissivity values of approximately 0.2 for new conductors and 0.9 for weathered bare overhead 

conductors have been reported by House and Tuttle. The exact rate of increase depends on the level of atmospheric 

pollution and the line’s operating voltage. A value of 0.5 has been widely used when the actual conductor surface 
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condition is unknown. The values entered here are subject to engineering judgment. 

Surface condition and corresponding absorptivity and emissivity values are shown below. 

 

• Black: 0.95/0.91 

• Non-Spec: 0.42/0.42 

• New: 0.23/0.23 

• Gray: 0.5/0.5 

• Average: 0.5/0.5 

2.3.6   Construction (Pro Version Only) 

For plexed covered conductors, the applicable construction, including Neutral Diameter, should be specified. For any 

cable, Insulation Thickness should be entered. 

 

2.3.7   Spec Sheet Information 

This panel contains conductor information that has no effect on the calculation results but will be printed on 

calculation output files. Some conductor types, such as ACSS, allow selection of the applicable core strength; RBS 

changes accordingly. 

 

2.3.8   Low Temperature and High Temperature AC Resistance 

Whereas steady-state calculations use calculated resistances, transient calculations use interpolated resistance. This is 

because transient calculations require a complex, iterative process to calculate transient ratings. To ensure resistance 
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interpolation and improve calculation accuracy, Low and High Temperatures and Low and High Temperature AC 

Resistances are recalculated for each transient calculation run based on calculation inputs. The Low and High 

Temperature AC Resistance values on the Main Menu are used for steady-state calculations only when Interpolate 

Resistance mode (Section 2.1.1, File Menu) is selected but for transient calculations are provided for reference only. 

 

2.3.9   Custom Materials 

A custom conductor or core Material may be selected from the Material drop-down. Once selected, the Custom Material 

Definition screen will appear. 
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There are three required input fields:  

• Material Name: Enter the custom material name 

• Alpha: Temperature Coefficient of Resistance, /°C 

• Rho: Conductivity, % IACS, or Volume Resistivity, Ω·cmil/ft 

2.4   Calculation Conditions  
There are two panels on the Main Menu that contain the specific calculation condition information. The Local 

Conditions panel contains information on the local operating conditions, and the Location Conditions panel contains 

assumptions related to the location of the line. For more information on these inputs, see your applicable conductor 

ratings standard.  
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2.4.1   Local Conditions  

 

• Ambient: Ambient air temperature, °C  

• Wind Speed: Wind speed, feet per second (ft/s) 

• Wind Angle: Angle between wind and axis of the conductor, degrees. A value of 90° indicates that the wind is 

blowing perpendicular to the conductor, providing maximum convection cooling.  

• Sun: Solar heat flux or intensity, W/ft2 (Pro version only). “Auto” calculates this value using other calculation 

conditions. SWRate Lite allows only the “Auto” calculation, while SWRate Pro allows both input and “Auto”. 

• Solar Day: Day of the year. The date chosen for the study impacts the position of the sun to the line, as does 

Local Time. 

• Local Time: Local sun time. The time of day affects the angle of the sun to the line, thus affecting the amount of 

heat transferred. To calculate for a no-sun condition, input a value of 24:00. For noon, input 12:00.  

2.4.2   Location Conditions  

 

• Frequency: Electrical frequency, Hz. Drop-down options are 50 Hz, 60 Hz, and dc. 

• Atmosphere: Relates to local air pollution levels. The type of Atmosphere affects the amount of solar radiation. 

The two available choices are Clear and Industrial.  

• Altitude: Elevation of the line above sea level, feet  
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• N. Latitude: North latitude of the line, degrees  

• Line Azimuth: Direction of the line, degrees. Values are 0° or 180° (line running North-South) and 90° or 270° 

(line running East-West).  

2.5   Output Selections 

 

2.5.1   Resistance (Resis.) Units 

A drop-down menu allows you to return calculation results in Ω/Mft (Pro version only), Ω/mi, or Ω/km units. If Ω/km is 

selected, additional values such as conductor information and calculation conditions will be converted to SI units when 

results are printed or saved. 

2.5.2   Temperatures 

A drop-down menu allows you to select a preset temperature range, enter a range of Custom temperatures, or enter a 

Range of evenly incremented temperatures. A preset temperature range is automatically selected based on the 

selected conductor Type. However, you can choose a different preset temperature range or select Custom or Range. 

Details on each are below. 

 

• Std   75°C: default temperature range for copper conductor types; up to 75°C 

• Std   90°C: temperature range up to 90°C 

• Std 100°C: default temperature range for standard conductor types; up to 100°C 

• Std 130°C: default temperature range for line wire and tree wire/spacer cable; up to 130°C 

• Std 200°C: default temperature range for C7®-TS conductor types; up to 200°C 

• Std 225°C: default temperature range for C7®-TP conductor types; up to 225°C 

• Std 240°C: default temperature range for ACCR and MaxStorm® conductor types; up to 240°C 

• Std 250°C: default temperature range for ACSS with mischmetal or AW core; up to 250°C 

• Custom: You can custom input up to 12 temperatures. The preset range is loaded by default into the table. 

Entered values can be input in °C or °F units. Entered values must be greater than or equal to 25°C (77°F). 
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• Range: You can define a Starting Temperature, Ending Temperature, and Increment. The software will then 

define a temperature range based on your inputs. For Calculate Ampacity and Batch Ampacity calculations, the 

temperature range should not be larger than 12. Entered values can be input in °C or °F units. Entered Starting 

Temperature and Ending Temperature values must be greater than or equal to 25°C (77°F). 
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2.6   Condition Settings (Pro Version Only) 
Four (4) buttons allow saving and selection of calculation conditions.  

 

• Profiles: Save various calculation conditions 

• Reset: Resets the calculation conditions to the default conditions 

• Restore Default: Restores the factory default calculation conditions 

• Save As Default: Saves the currently input calculation conditions as your default conditions  

The default conditions provided with the SWRate software do not constitute a recommendation by Southwire as to the 

appropriate conditions for your study, nor are they intended to replace engineering judgment, which you, the designer, 

should exercise in determining calculation conditions appropriate to your installation and operating conditions. 

2.6.1   Profiles 

Save various calculation conditions in tabular form to easily switch between rating assumptions. This is especially useful 

for consultants that work with many clients. Absorptivity and emissivity can also be included in Profiles. The Import 

button allows calculation conditions from the Main Menu to be imported into a new row in the Profiles screen. 

2.6.2   Reset 

Resets the calculation conditions to the factory default conditions 

2.6.3   Restore Default 

Restores the default calculation conditions 

2.6.4   Save As Default 

Saves the currently input calculation conditions as your default conditions. If the calculation conditions used for your 

studies are different from SWRate’s default conditions, you may want to enter your specific conditions and save these 

as the defaults. Doing so will overwrite the defaults provided with SWRate software. These new defaults will then be 

loaded whenever the program is run. If at any time you want to reset the default conditions to their factory values, you 
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can do so using the Reset button and then clicking the Save As Default button. 

2.7   Calculation Options  
There are nine (9) calculation options available in SWRate software: one is for Loss of Strength calculations, two are for 

Steady-State calculations, two are for Transient calculations, one is for calculating ampacity charts (Pro version only), 

one is for batch ampacity charts (Pro version only), one is for batch spreadsheet calculations (Pro version only), and the 

last is for Bundle Calculations (Pro version only).  

 

Note that for single-layer steel core conductors (aluminum-clad steel, AW, excluded), values above 75°C may be 

incorrect due to limited data for modeling. 

2.7.1   Loss of Strength  

Given a conductor operating temperature (Temp) in °C and cumulative time duration (Time) in hours, the program will 

calculate the Remaining Strength of the conductor in terms of the percent of the rated breaking strength (%RBS). This 

option is only available for the following standard conductor types: AAC-based conductor types (including covered 

conductors), AAAC-based conductor types (including covered conductors), ACAR, AACSR, and ACSR-based conductor 

types (including covered conductors). High-temperature low-sag (HTLS) conductors (e.g., ACSS, C7® Overhead 

Conductors, MaxStorm® Overhead Conductors) have high normal operating temperatures and have very low risk of 

strength loss. Loss-of-strength calculations should not be performed for Custom conductors. 

 



SWRate User’s Manual v2.2.1 Page 28 of 44 

 

 
 

Some degradation of tensile strength due to conductor heating is inevitable; however, a maximum 10% loss of strength 

over the life of the line is generally considered conductor end-of-life. Remaining Strength calculations in the program 

use the formulas presented in Harvey, J.R., “Effect of Elevated Temperature Operation on the Strength of Aluminum 

Conductors,” which are intended for approximations only.  

 

Loss of Strength calculations can also be used to determine the Remaining Strength when several occurrences of high-

temperature operation have occurred since the effects of each occurrence are cumulative. When various time-

temperature exposures need to be considered, use the method below to determine the conductor remaining strength. 

1. Calculate the Remaining Strength after the assumed exposure Time at the lowest Temperature. 

2. Iteratively calculate the Time required at the next higher Temperature to yield the Remaining Strength 

calculated in Step 1. 

3. Add the Time calculated in Step 2 to the exposure Time at the Temperature from Step 2. 

4. Calculate the Remaining Strength using the total Time calculated in Step 3 and the Temperature from Step 2. 

5. Repeat Steps 2-4 until the Remaining Strength at the highest Temperature is calculated. The total equivalent 

exposure Time will accumulate with each new, higher Temperature exposure considered. The final Remaining 

Strength calculation at the highest Temperature exposure will be the Remaining Strength of the conductor 

considering all the various time-temperature exposures. 

 

Since consideration of the individual components separately is necessary, hand calculations are needed to calculate the 

remaining strength for ACAR and ACSR conductors after various time-temperature exposures. Refer to Harvey, J.R., 

“Effect of Elevated Temperature Operation on the Strength of Aluminum Conductors,” or to the Southwire Overhead 

Conductor Manual, 3rd Edition, for more information on performing these calculations by hand. 

2.7.2   Steady-State Conductor Temperature  

Selecting this option will calculate a steady-state conductor temperature based on an input current load. To run this 

calculation, first select a conductor and input the desired calculation conditions (Local Conditions and Location 

Conditions). Click the Conductor Temperature button in the Steady-State panel and the Steady-State Current Input 

screen, shown below, will appear. 

 

Enter a value for the Steady-State Current in amperes. Click Calculate and the Steady-State Temperature Rating results 

screen, shown below, will be displayed. 
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This screen displays the calculated Steady-State Temperature Rating for the Steady-State Current provided, the solar 

heat gain (Qs), the convection heat loss (Qc), the radiated heat loss (Qr) and the ac resistance at the calculated 

conductor temperature (Rac).  

 

From this screen, you can Print the report or Save it to a .doc file. The report will contain the calculated data shown as 

well as the conductor information and calculation conditions from the Main Menu. 

2.7.3   Steady-State Current Rating 

Selecting this option will calculate a steady-state current rating based on an input conductor temperature. To run this 

calculation, first select a conductor and input the desired calculation conditions (Local Conditions and Location 

Conditions). Click the Current Rating button in the Steady-State panel and the Steady-State Temperature Input screen, 

shown below, will appear.  
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Select the Temperature Units for the steady-state conductor temperature, and then enter a Temperature value. Click 

Calculate and the Steady State Current Rating results screen will be displayed. The only difference will be that the 

conductor current rating is displayed instead of a conductor temperature. The same output options are available.  

2.7.4   Transient Conductor Temperature (Unavailable for Covered Conductors) 

Selecting this option will calculate the maximum conductor temperature resulting from a temporary step increase in 

current, assuming no change in weather conditions and the conductor is at thermal equilibrium prior to the step 

increase in current. To run this calculation, first select a conductor and input the desired calculation conditions (Local 

Conditions and Location Conditions). Click the Conductor Temperature button in the Transient panel and the Transient 

Data Input screen, shown below, will appear. 

 

To perform a transient calculation, there are several inputs required:  

• Metal Heat Capacities: This calculation is based on the material properties of the conductor. The program will 

load default Weight and Specific Heat values for the materials found in the selected conductor type (both Core 

and outer conducting (AL/CU) strands) and calculate the Metal Heat Capacity of the conductor. The values 

provided are defaults used in the industry, and you should verify that these values are appropriate for the 
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conductor being used.  

• Specify an Initial Steady State: An Initial Steady-State Temperature or Current must be specified. If a Current 

load is entered, the program will use the steady-state algorithm to calculate the conductor temperature prior to 

the application of the transient current load. Note that the Initial Steady-State Temperature should be (1) 

greater than the ambient temperature and (2) greater than 25°C (77°F). If an Initial Steady-State Current is 

specified and the resulting steady-state temperature is less than 25°C (77°F), the temperature will be elevated 

to 25°C (77°F) for the transient calculation to maintain calculation accuracy.  

• Specify Calculation Time Interval: A Time Interval for calculating the transient condition must be entered. This 

will dictate how many calculations are run during the time the transient condition exists. This will also 

determine the time axis values for the transient temperature Plot option.  

• Transient Calculation Data: In this panel, the New Conductor Current, including step increase, and the Total 

time duration for the transient in minutes or seconds is entered.  

Note that the same input screen is used for both the transient Conductor Temperature and Current Rating 

calculations. The only difference occurs in the Transient Calculation Data panel. For a transient Conductor 

Temperature calculation, the New Conductor Current is input, while the Max Conductor Temp. is input for a transient 

Current Rating calculation.  

 

Click the Calculate button to run the transient calculation. The Transient Calculation Results screen, shown below, will 

be displayed. 

 

The Transient Calculations Results screen displays the Initial Steady-State Conductor Temperature and Current, the 

conditions input for the transient, and in this case, the Maximum Transient Conductor Temperature resulting from the 

input Maximum Transient Current for the indicated Transient Time Duration.  
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From this screen, you can Print the report or Save it to a .doc file. The report will contain the calculated data shown as 

well as the Metal Heat Capacities and conductor information and calculation conditions from the Main Menu. 

Additionally, the Recalculate button will return the program to the previous screen to allow changes in the transient 

conditions. The Plot button will plot the temperature rise over time resulting from the transient step current, as shown 

below. 

 

From this screen, a Print of the plot can be made.  

 

Note that transient calculations use interpolated resistance. This is because transient calculations require a complex, 

iterative process to calculate transient ratings. To ensure resistance interpolation and improve calculation accuracy, 

Low and High Temperatures and Low and High Temperature AC Resistances are recalculated for each transient 

calculation run based on calculation inputs. 

2.7.5   Transient Current Rating (Unavailable for Covered Conductors) 

Selecting this option will calculate the Maximum Transient Current based on a Maximum Transient Conductor 

Temperature, assuming no change in weather conditions and the conductor is at thermal equilibrium prior to the step 

increase in current. To run this calculation, first select a conductor and input the desired calculation conditions (Local 

Conditions and Location Conditions). Click the Current Rating button in the Transient panel and the Transient Data 

Input screen will appear.  

 

The only difference in this screen and the one provided for the transient conductor temperature option is a Max 
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Conductor Temp. must be entered into the Transient Calculation Data panel instead of a New Conductor Current. The 

Max Conductor Temp. must be at least 10°C (18°F) higher than the ambient temperature. Also note that the Initial 

Steady-State Temperature should be (1) greater than the ambient temperature and (2) greater than 25°C (77°F). If an 

Initial Steady-State Current is specified and the resulting steady-state temperature is less than 25°C (77°F), the 

temperature will be elevated to 25°C (77°F) for the transient calculation to maintain calculation accuracy. 

Click the Calculate button to run the transient calculation. The Transient Calculation Results screen will be displayed. 

The only difference in this screen and the one from the transient conductor temperature calculation is that the Plot 

option is unavailable. 

 

Note that transient calculations use interpolated resistance. This is because transient calculations require a complex, 

iterative process to calculate transient ratings. To ensure resistance interpolation and improve calculation accuracy, 

Low and High Temperatures and Low and High Temperature AC Resistances are recalculated for each transient 

calculation run based on calculation inputs. 

2.7.6   Calculate Ampacity (Pro Version Only) 

This calculation creates tabulated steady-state ampacity results using the Temperatures defined in the Output 

Selections panel. To run this calculation, first select a conductor and input the desired calculation conditions (Local 

Conditions and Location Conditions). Confirm your Temperatures in the Output Selections panel or make changes as 

desired. Click the Calculate Ampacity button in the Advanced panel and the Results screen will appear. For single-layer 

steel core conductors, a Calculating Single-Layer Values screen will appear prior to the Results screen to track the 

progress of this complex calculation. 

 

The Results screen includes operating temperatures in °C and °F (reflective of 20°C (68°F) and the defined 

Temperatures), DC and AC Resistance, ampacity under various Sun and Wind conditions, conductor GMR, and 

Inductive (Xa/Xl) & Capacitive Reactance (X’a/Xc) at 1-ft spacing (spacing is non-applicable for plexed covered 

conductors). For dc calculations, GMR and Inductive & Capacitive Reactance are non-applicable. 
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Available buttons and options on the Results screen: 

• Print: Print the report. The report will contain the tabulated data shown as well as the conductor information 

and calculation conditions from the Main Menu. 

• Save: Save the report to a .doc file. The report will contain the tabulated data shown as well as the conductor 

information and calculation conditions from the Main Menu. 

• View Sequence Impedance Data (non-applicable for dc calculations): View the Sequence Impedance Results 

screen (see below). The screen includes operating temperatures in °C and °F (reflective of 20°C (68°F) and the 

defined Temperatures), DC Resistance, R (positive sequence ac resistance), Xl (positive sequence inductive 

reactance), Xc (positive sequence capacitive reactance), R0 (zero sequence ac resistance), Xl0 (zero sequence 

inductive reactance), Xc0 (zero sequence capacitive reactance), GMD (as defined in File => Options => 

Sequence Impedance Inputs), Line Height (as defined in File => Options => Sequence Impedance Inputs), 

conductor GMR, and Inductive (Xa/Xl) & Capacitive Reactance (X’a/Xc) at 1-ft spacing (spacing is non-applicable 

for plexed covered conductors). 

• Include Sequence Impedance Data with Printout (unavailable for dc calculations): A separate printout that 

includes sequence impedance data will be printed prior to the ampacity results. 
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Note that for single-layer and three-layer steel core conductors (aluminum-clad steel, AW, excluded), ac resistance is 

calculated at the highest current shown for each temperature. For single-layer steel core conductors (aluminum-clad 

steel, AW, excluded), inductive reactance is calculated at the highest current at 75°C. 

2.7.7   Batch Ampacity (Pro Version Only) 

This calculation outputs a collection of tabulated ampacity calculation sheets using the Temperatures defined in Output 

Selections. To run this calculation, first select a conductor Type and input the desired calculation conditions (Local 

Conditions and Location Conditions). Confirm your Temperatures in the Output Selections panel or make changes as 

desired. Click the Batch Ampacity button in the Advanced panel and the Multiple Conductor Selection screen will 

appear.  
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This screen displays the conductor options and allows you to select multiple conductors. Also note the Select All option 

at the top of the screen. Keep in mind that these calculations could take some time. Once you have made your 

selections, click Accept. A Print screen will appear to confirm your printer selection before proceeding with the 

calculations and printing.  

 

For single-layer steel core conductors, a Calculating Single-Layer Values screen will appear prior to the Results screen 

to track the progress of this complex calculation. Each printed report will contain the tabulated data as described in 

Section 2.7.6, Calculate Ampacity. 

 

Note that for single-layer and three-layer steel core conductors (aluminum-clad steel, AW, excluded), ac resistance is 

calculated at the highest current shown for each temperature. For single-layer steel core conductors (aluminum-clad 
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steel, AW, excluded), inductive reactance is calculated at the highest current at 75°C. 

2.7.8   Create Spreadsheet (Pro Version Only) 

The Create Spreadsheet calculation produces a spreadsheet of steady-state and transient results for multiple 

conductors and multiple sets of calculation conditions (up to 50), including columns for conductor properties, 

resistance, and reactance. To run this calculation, first select a conductor Type and input the desired calculation 

conditions (Local Conditions and Location Conditions). If multiple sets of ampacity calculations [e.g., ambient-adjusted 

ratings (AAR)] are desired, only Location Conditions need to be entered at this time. Click the Create Spreadsheet 

button in the Advanced panel and the Multiple Conductor Selection screen will appear as shown in Section 2.7.7. This 

screen displays the conductor options and allows you to select multiple conductors. Also note the Select All option at 

the top of the screen. Keep in mind that these calculations could take some time if single-layer ACSR conductors and/or 

transient calculations are specified. Once you have made your selections, click Accept. A screen will appear asking if 

you would like to specify multiple sets of Local Conditions for your calculation.  

 

Clicking Yes or No on the multiple sets of Local Conditions screen will yield a second screen asking if you want to 

calculate transient ratings as well (unavailable for covered conductors). If you click Yes, the Transient Ampacity Input 

screen will appear as shown below. Clicking Yes on the multiple sets of Local Conditions screen will cause the Transient 

Ampacity Input screen to appear after the Local Conditions screen. 
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To calculate transient ratings within Create Spreadsheet, several inputs are required:  

• Metal Specific Heats: Unlike the single transient calculation, Weights are not editable since the Create 

Spreadsheet calculation handles multiple conductors, all with different Weights. Transient rating calculations 

are based on the material properties of the conductor. The program will load default Specific Heat values for 

the materials found in the selected conductor type (both Core and outer conducting (AL/CU) strands). The 

values provided are defaults used in the industry, and you should verify that these values are appropriate for 

the conductor being used. 

• Transient Calculation Data: 

o An initial steady-state Starting Current must be specified as a Percent of the calculated Steady-State 

Current at Tc. You must specify a Percent (default is 100%) and temperature. You may specify 

temperature As Defined in Output Selections (your temperature range) or by a single Input 

temperature.  

o A Max Conductor Temp. during the transient must be specified As Defined in Output Selections (your 

temperature range) or by a single Input temperature. If the As Defined in Output Selections 

radiobutton is selected, a Percent lower than 100% must be specified in the Starting Current section. 

The Max Conductor Temp. must be at least 10°C (18°F) higher than the ambient temperature. Also note 

that the initial steady-state temperature should be (1) greater than the ambient temperature and (2) 

greater than 25°C (77°F). If an initial steady-state current yields a steady-state temperature less than 

25°C (77°F), the temperature will be elevated to 25°C (77°F) for the transient calculation to maintain 

calculation accuracy. 

o Total time duration for the transient in minutes or seconds must be entered (15 minutes is default) 

o Conductor Temperature to be calculated every – A time interval for calculating the transient condition 

must be entered. This will dictate how many calculations are run during the time the transient condition 

exists. 

 

Clicking Yes on the multiple sets of Local Conditions screen will cause the Local Conditions screen to appear as shown 

below. Use the Add Column button to add your desired number of columns (up to 50). If Night calculations are desired, 

click the Include Night calculations checkbox before clicking Add Column. To update the values in a column, click on 

any value within a column, then use the Local Conditions panel on the left side of the screen to edit the column values 

before clicking Update Table. The calculation conditions specified in each column will be used to calculate steady-state 

ampacities for the temperature range. 
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Click the Calculate button to proceed with Create Spreadsheet calculations. The Input File Path and Name screen will 

be displayed. 

 

Click Browse to select a destination for your output .xlsx file. Also edit the Filename as needed. Click Accept when 

ready to initiate the calculations. For single-layer steel core conductors, a Calculating Single-Layer Values screen will 

appear to track the progress of this complex calculation. The Building Excel File screen will also appear to track the 

progress of the overall calculation. Once the calculation finishes, these screens will disappear, the .xlsx file will be saved 

to the specified destination on your computer, and a message box will appear, confirming successful spreadsheet 

creation. If multiple sets of calculation conditions were specified, the .xlsx file will include a worksheet for each set of 

conditions, including a unique worksheet for each Night calculation. If errors were encountered during the calculation, 

those will be summarized in a .txt file and saved (with a similar filename) in the same directory as the .xlsx file. 

 

Note that transient calculations use interpolated resistance. This is because transient calculations require a complex, 

iterative process to calculate transient ratings. To ensure resistance interpolation and improve calculation accuracy, 

Low and High Temperatures and Low and High Temperature AC Resistances are recalculated for each transient 

calculation run based on calculation inputs. 

 

Note that for single-layer and three-layer steel core conductors (aluminum-clad steel, AW, excluded), ac resistance is 

calculated at the highest current shown for each temperature. For single-layer steel core conductors (aluminum-clad 
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steel, AW, excluded), inductive reactance is calculated at the highest current at 75°C. 

2.7.9   Bundled Calculation (Pro Version Only) 

Calculate the inductive and capacitive reactances for a provided bundle and phase configuration (unavailable for dc 

calculations). To run this calculation, first select a conductor and input the desired calculation conditions (Local 

Conditions and Location Conditions). Click the Bundle Calculation button in the Advanced panel and the Bundle 

Calculation Information screen will appear. 

 

Choose from various Bundle Configurations and Phase Configurations. When a radiobutton is selected, the Bundle 

Info screen will appear so that you can enter the applicable distances between conductors. 
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Click the Calculate button to run the bundle calculation. The Bundle Calculation Results screen, shown below, will be 

displayed. From this screen, you can Print the report. The report will contain the calculated data shown as well as the 

conductor information and calculation conditions from the Main Menu. Only calculation conditions that affect the 

calculation result will be shown in the printout. 
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Abbreviations 
Conductor Types 

AAC  All-Aluminum Conductor 

AAC/TW  Shaped Wire Compact All-Aluminum Conductor 

AAAC All-Aluminum Alloy Conductor (6201-T81 Alloy) 

ACAR  Aluminum Conductor, Aluminum Alloy Reinforced (1350/6201 Alloy) 

AACSR  Aluminum Alloy Conductor, Steel Reinforced (6201-T81 Alloy) 

ACSR  Aluminum Conductor, Steel Reinforced 

ACSR/TW  Shaped Wire Compact Aluminum Conductor, Steel Reinforced 

ACSR/MR Motion-Resistant Aluminum Conductor, Steel Reinforced (also known as “Oval”) 

ACSR/AW  Aluminum Conductor, Aluminum-Clad Steel Reinforced 

ACSS  Aluminum Conductor, Steel Supported 

ACSS/TW  Shaped Wire Compact Aluminum Conductor, Steel Supported 

ACSS/AW  Aluminum Conductor, Aluminum-Clad Steel Supported 

ACSS/TW/AW  Shaped Wire Compact Aluminum Conductor, Aluminum-Clad Steel Supported 

MaxStorm® Shaped Wire Compact Thermal-Resistant Aluminum Conductor, UHS Steel Reinforced 

(ZTACSR/TW/MA5) 

ACCS/TW/C7®-TS Shaped Wire Compact Aluminum Conductor, Thermoset Composite Supported 

ZTACCR/TW/C7®-TS Shaped Wire Compact Thermal-Resistant Aluminum Conductor, Thermoset Composite 

Reinforced 

ACCR Thermal-Resistant Aluminum Conductor, Composite Reinforced 

ACCR/TW Shaped Wire Compact Thermal-Resistant Aluminum Conductor, Composite Reinforced 

AAC/VR2®  Vibration-Resistant, Twisted Pair All-Aluminum Conductor 

ACSR/VR2®  Vibration-Resistant, Twisted Pair Aluminum Conductor, Steel Reinforced 

Al  Aluminum 

Cu  Copper 

Duplex  Covered conductor plexed with a bare neutral 

Triplex  Two covered conductors and a bare neutral, all plexed together 

Quadruplex  Three covered conductors and a bare neutral, all plexed together 

HD Copper  Hard-Drawn Copper 

MHD Copper  Medium-Hard-Drawn Copper 

SD Copper  Soft-Drawn Copper 

Line Wire  Single Covered Conductor 

Tree Wire  Single Covered Conductor designed for momentary contact with trees 

Spacer Cable  Single Covered Conductor designed for spacer cable systems 

Other 
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AC Alternating Current 

DC Direct Current 

GA# Galvanized Zinc Steel Core Coating (# equals strength rating) 

GMD Geometric Mean Distance, between conductors 

GMR Geometric Mean Radius, used in inductive reactance calculations 

HS285® Southwire proprietary Ultra-High Strength Steel Core 

MA# Mischmetal Steel Core Coating (# equals strength rating) 

TW  Trapezoidal-Shaped Wire 


